
PROJECT COMMANDER – PLANNING SOFTWARE
www.projectcommander.co.uk 
Project Commander – updated features from version 6.23 to version 6.3

· Quick Start wizard – Weekly projects

· Quick Start wizard – Hourly projects

· User log for Network users

· Freeform text locking

· Undo levels extended to 20

· New Task Form

· Date constraints on linked bars

· Font Wizard

· Change in View menu

· Choosing bar colours

· PDF icon

· Project Month numbers added to Timescale

· Formula columns

· Hammock tasks

· Summary bar text roll ups

· Summary bar representation toolbar icon

· Filter – enhanced to 5 levels

· Multiple Baselines

· Multiple Progress lines

· Consolidation

· Report Generator

· New Resource Sheet

· Resource Group assignments

· Resource assignments using the Resource Assignment window

· Constant Effort & Duration option for resource assignment

· View by & sort by Resource team, skill or location

· Filter by Resource team, skill or location

· Intelligent paging

· Report settings

· Reports - Progress

· Reports - Costs

· Reports - Resources

Quick Start Wizard
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When you start up Project Commander, you can choose to invoke assistance setting up the project using the QUICK START option.

	TITLE
	Insert  2 lines (centred at the top of the chart)

	TIMESCALE

	 - FROM & TO
	The time range for the chart

	 - WEEK ONE DATE
	If Project Weeks are included in timescale, this is the week numbered ONE

	HEADINGS

	 - WEEK COMMENCING 
	Changes weeks at top of chart to week commencing dates using Monday dates

	 - PROJECT WEEKS
	Changes weeks at top of chart to project week numbers using the Week One Date above

	 - DAY & DATE
	Changes headings at top of chart to month, date & day of the week

	 - HIDE WEEKEND SHADINGS
	Turn off shadings on chart for weekends only (not holidays)

	CHART FORMAT

	 - ID
	Original line numbering

	 - LINE NUMBER
	Replace original line numbering with consecutive row numbers (useful if report is filtered)

	 -NUMBER TASKS ONLY
	Number lines that have task bars only

	SUMMARY BARS

	 - SUB TASK COLOURS
	This shows a summary bar made up of the colour of the sub bars below it

	 - SOLID
	The summary bar appears as a white bar with a black start & end symbol

	DATE FORMAT

	 - DD/MM/YY
	Date only

	 - DD/MM/YY HH:MM
	Date and time of day

	ATTACH ROW NUMBER TO LEFT
	The row number is printed at the start of each bar – not summary bars

	PAGE FORMAT

	LINES/PAGE
	Number of task rows on the chart for each page

	USE BORDER
	Puts a default border/frame around the chart

	SHOW TODAYS DATE
	Puts the pc’s current date at the top right of page

	SELECT PRINTER 
	Shows the current printer and allow you to change the printer, paper size or orientation


Hourly Wizard

When you start up Project Commander, you can choose to invoke assistance setting up the project using this QUICK START option It allow users to set up short term plans in hours.
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	PROJECT START
	The start of the chart uses this date and the earliest time from the calendar chosen (working hours) below

	TIMESCALE HEADINGS
	There are 7 options for the time headings at the top of the chart

	HOURS START FROM 00
	The first hour after midnight can be counted as 00 or 01. The default is to be ticked and counts the hours from 0-23. If the box is not ticked, the count starts from 1 to 24

	NUMBER OF DAYS
	Number of calendar days in chart

	WORKING HOURS

	DEFAULT
	The working days and times is set to the default calendar. If not changed from installation, it will be based in 5 days per week & 8 hours/day (9am-5pm)

	24/5
	This changes the calendar to allow 24 hour working – every Monday to Friday

	24/7
	This changes the calendar to allow 24 hour working  every day of the every week

	OPTIONS  - the following options may not be available depending on the option picked for the Working Hours above

	HIDE NON WORKING
	Only show hours that are working hours

	SHADE NON WORKING
	Show non working hours – but shade them

	HIDE WEEKENDS
	Exclude all Saturday and Sundays

	HOURLY GRIDLINES
	Draw a vertical line down each hourly interval


Every time the HOURLY CHART wizard is run, it will change the presentation of the chart.

If you use A4 landscape paper, then only pick a maximum of 2 calendar days if you want to show all hours ..
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If you use A4 landscape paper, if you pick the DEFAULT CALENDAR then only pick a maximum of 5 calendar days if you choose to HIDE NON WORKING HOURS, but NOT HIDE WEEKENDS ..

[image: image187.png]Warch | April

e 1 2 3 4
| | | |

M | T | w | T | F

1091101112131 4151 80810y11/121314 1611 Bi0810,11/12/131 41516081011 11213,14/15/1808/10/11 12,1311 415/15|





If you use A4 landscape paper, if you pick the DEFAULT CALENDAR then only pick a maximum of 8 calendar days if you choose to HIDE NON WORKING HOURS & HIDE WEEKENDS ..
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Important – to get a larger range of days, you must either pick a printer that handles A3 or higher (select the FILE menu & PRINT SETUP) or you can print the chart on more than one piece of paper horizontally (select the FORMAT menu & PAGE SETUP. Change the setting highlighted to a value of 2 or above)

In this example the chart will be printed out over 3 pages horizontally – as if they are continuous. You would need to tape the pages together after printing.

User Log for network users
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· Select HELP menu, ABOUT PC – this confirms the number of Licences registered and the number of current users on-line

· Click on VIEW LICENCE INFORMATION box – to list all workstation users currently on-line.

Important

Users on a network version, must exit the program using FILE menu & EXIT or it will still count the user on the network. In order to clear a user that is logged on in error, the workstation must start up Project Commander and exit out properly. If that does not clear or the user cannot be cleared – you will need to re-install the software.

Freeform text locking
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By default, freeform text is placed on a position on the page – so if the timescale or extra columns/rows are added – the text does not move.

There are now options to lock text to a date and/or a specific row.

Undo levels

The number of undo/redo levels has been extended to a maximum of 20 (default). This level will be reduced automatically to 5 if the system detects low memory.

(see OPTIONS menu, PREFERENCES, GENERAL tab)

Important

For large files – the Undo save will incur extra processing time after every operation. If there is a marked delay after clicking an OK button – it may be caused by this function and setting the option to 0 – may improve speed of processing.
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New Task Form

VIEW menu, TASK FORM

This splits the screen and puts a Form on the bottom window that covers all information regarding a task (or summary task). The form is tabbed into different categories …
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The task row can be selected by clicking on the PREVIOUS & NEXT buttons on the form or by clicking on a chart-based View or Report in the top split window.

If any data is edited in the form the PREVIOUS/NEXT buttons will change to OK & CANCEL and the task information is not updated until after OK is clicked
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If the task is a Summary bar, then many of the fields will be ghosted out as impossible to update.

To switch off the TASK FORM, click on VIEW menu, TASK FORM or on the X at the top left of the bottom window.

Important 

A truncated option of the form is still available by double clicking on the ID number.

Date Constraints on linked tasks
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On any task, the date a task (only the first task bar on any line) starts or ends  can be set to override the link condition – if it conflicts. By default the option is set as  ASAP – as soon as possible, which means that the bar will start as early as the link will allow. The other options are …

In order to access the option, you use the TASK FORM ..

· VIEW menu, TASK FORM

· Click on the LINKS tab
[image: image4.png]B D1 Name: [ Stat: [06/06/04 =] Duratone[134 =] Fiish: 2470
Froject [Froject 1 Outine[1 =] oy

Resourcs | Plarmed | Progeess | Dosts | Codes | Uset Test 110 | User Test 1120 Links, Constiits and CPA |




· Click on DOWN ARROW against TYPE and choose one of the above options from the list above.
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· For every option apart from AS SOON AS POSSIBLE & AS LATE AS POSSIBLE, you need to enter a date

In the following example a constraint will change the date the task finishes ..

BEFORE
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AFTER
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· Font Wizard
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There are several wizards under the WAND ICON in the toolbar. Click on FONTS.
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This option controls global fonts on different areas of the chart. 

1. Document Title = main heading at top of chart

2. Sub Heading = secondary heading at top of chart

3. Column Headings = headings above each data column

4. Column Data = text in all data columns (for non summary tasks)

5. Timescale = headings above the chart area

6. Bar Text = text attached to bars

7. Summary Tasks = text on the whole row of data associated with summary tasks only 

Important

Individual fonts in cells can override the global settings, by selecting a single cell or dragging over a range of adjacent cells and then choosing FORMAT menu, FORMAT CELLS, FONT or by selecting the cells and changing the formatting options in the toolbar ….
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Change in View menu

The View menu has been changed and several of the progress, resource and cost views have been moved to the Reports menu.

The Override view has been renamed as the TASK DATES view …

[image: image10.png]start | Finsn
tame overiaeoverriae|PUraon

020008 [orosos | o

020404 150806 [ 106

0904/04 0s 05106 200

505,04 [or050¢ |10

T3050¢[oa0s0| 1





[image: image201.png]Optons:
I~ Lse curency famat
I~ Roundup

I~ Set deciml places

Duration units:
 Minutes
& Hous

© Daye



Choosing bar colours

Whenever, a colour is set up in the Legend or a colour is used in the Bar Selector, the bars are moved to the top of the list in the Bar Selector for easy & quick allocation to bars.

PDF icon
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The PDF icon in the toolbar now will save the file in PDF format using JAWS or ADOBE – if one is available. 

Important

PDF files can be saved by printing to a JAWS or ADOBE.

Project Months added to timescale

To edit the chart time headings, select the FORMAT menu, TIMESCALE. To change a heading (say from Week commencing to Project Month)…
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Click on the CUSTOMISE tab

· Click on the WEEKS heading
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· Click on the DOWN ARROW under UNITS and choose MONTHS

· Click on the DOWN ARROW under LABEL and choose the option above

The headings will start at 1 in the first month – based on the WEEK ONE DATE held in OPTIONS menu & PROJECT INFO
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Formula columns

There are 3 special columns that can be used to calculate values using a use defined formula.

The fields available for calculation are …
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durations

2. costs

3. % complete figures

4. resource effort

DURATION
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In order to insert a formula column ..

· Click on a heading

· Select the EDIT menu & INSERT COLUMNS
· Click on the DOWN ARROW on the type field and choose FORMULA 1

· Click on EDIT FORMULA

· Choose a column (say Duration)

· Click on ADD TO FORMULA

· It then appears in the top window – see below
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· Click on the mathematical operator below  (say – minus) ….
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· Choose a column (say Baseline Duration)

· Click on ADD TO FORMULA

· It then appears in the top window – see below
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Important

On the OPTIONS, you have

selections for numerics 

and also to translate task 
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and resource durations

· In this example, the Durations are in days, so click on DAYS & DECIMALS to 1

[image: image212.png]eporting Date

30/04/2004




[image: image15.png]Name.

Basen

Durstion 2o

150 | 10




 




· Click on OK twice
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COSTS

Say you wanted to convert the costs to Euros. The formula would be …

· Choose column TOTAL COSTS

· Click on ADD TO FORMULA

· Click on the multiply sign
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· Input a value (say 1.6) to represent the exchange rate

· Click on ADD TO FORMULA
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· Click on USE CURRENCY FORMAT
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· Click on OK twice
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Important

The Currency rate could be held in a USER column
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% PROGRESS
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RESOURCE HOURS
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It is important that the DURATION UNITS are same as the Resource column
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Hammock tasks

Hammock tasks are bars that have a start & end link to other bars and the duration is stretched/shortened dependant on the link.
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Normally if there are 2 links feeding into a bar, the bar will be scheduled using the link that sends it the latest …
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To make the bottom bar a hammock, double click on the ID number 3 and change the HAMMOCK TASK box from No to Y(for YES)

The bar now is stretched between the 2 links.
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If the type of link or the duration of the preceding bars changes, the hammock bar will change
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Summary bar text roll ups
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Not only can the colour of sub tasks be rolled up to the owning summary bar, but also any visible text attached to any sub bar (not freeform text) can be rolled up too.
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Double click on the ID number 1 and change the ROLLUP LABELS box from NO to Y(for YES)
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Important 

Rollup text only works when the summary bars use the default setting.

Summary bar representation toolbar icon

There are 2 ways to display summary bars – as rolled up colours or as a standard bar. By default the summary bar has rolled up colours, there is now a toolbar icon  [image: image31.png]


– that will change all summary bars to a standard format 
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Important

In order to reverse back to default setting – click on icon again.

User defined filter – 5 levels

[image: image33.png]D Name. start |ouraton
oy 154
2 7
B oross| s
O EEE
s 1eos0s| 3¢
o os0s|





In the above example, click on the FILTER icon [image: image34.png]


 and set the options as follows…
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This will just show the following result (of only one bar selected)
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Important

The filter is taken off by clicking on the SHOW ALL icon in the toolbar [image: image37.png]



Also the FILTER remains active on all chart based reports & views until the filter is changed or removed.

Several tests have now been added … [image: image218.png]Report Wizard
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Multiple Baselines
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More than one baseline can be saved and displayed along with the current bar on a chart . The name for baseline can be set by …

· OPTIONS menu, BASELINE, SAVE
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Click on NEW

· Enter the name
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To save a second baseline, repeat the above an
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In order to compare the actuals to more than one Baseline on any chart based report, select ….

· OPTIONS menu, BASELINE, SELECT
· Highlight each Baseline individually (under SAVED BASELINES)

· Click on ADD to include it in the list of ones to show

[image: image221.png]Test

Mot Equals

Greater Than

Greater Than 01 Equals
Less Than

Loss Than 01 Equals
Cortains

Doss Not Contain




[image: image40.png]Saved Baselines

Baseine 1

Baseine - Apil 2004

Bassines | Prores Lnes |

Add >

Remove

Baseline Ao 200

>




[image: image41.png]var | Apr |

D Name. Start |Duration| Finish
2 205 12 10203

1 | summary 200904 | 134

2= 00004 | 34

afe nove4| 44

afe 290404 | 54 [ososos —




[image: image222.png]Create Resource Group

GowName: [GanGa

I~ Use work based durstons
Units

Resaurces:

B General
Electicians
Joiers




Important

The colour of the Baselines are allocated automatically. The colour can be changed and displayed in the legend – by selecting FORMAT menu, SYMBOLS.
The order of the baseline lines are in the order shown by in the SELECT BASELINES window above.

Whenever a baseline is saved, task dates, % complete, resource and cost data are all saved. The baseline at the top of the list will provide the data for any Baseline figures in any report (You cannot compare multiple baselines on a report or graph).

Multiple Progress Lines

If a project is updated with a % Complete, if a new Baseline is saved at each reporting period, the latest % complete is saved.
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· First, select the OPTIONS menu, PROJECT INFO and click OFF the REPORTING DATE and click ON PROGRESS LINE…

· Select the VIEW menu & PERCENT COMPLETE
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Change REPORTING DATE to end of next period (week or month)

· Enter an ACTUAL of 80%
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· Select the OPTIONS menu, BASELINE, SAVE
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· Click on OK
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Then select the VIEW menu & PERCENT COMPLETE
· Change REPORTING DATE to end of next period (week or month)

Enter updated % complete
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· Select the OPTIONS menu, BASELINE, SAVE
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· Click on NEW and then OK.

Then in order to show the 2 Progress Lines …

· OPTIONS menu, BASELINE, SELECT
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Click on the PROGRESS LINES tab

· Highlight each Baseline individually (under SAVED BASELINES)

· Click on ADD to include it in the list of ones to show
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Click OFF the SHOW BASELINE box
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Select the OPTIONS menu PROGRESS INFO 

· Click OFF both progress line options….
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Consolidation

The consolidation operation has been enhanced and simplified.

Important

All the files needed to be consolidated – should be either saved into the same folder or copied into one.
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To consolidate several files …
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FILE menu, NEW

· FILE menu, CONSOLIDATION, INSERT
· Hold the CONTROL key down, and click on each file to consolidate.
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If any file is updated (say Job 111 is updated to 900h), then while the Consolidated file is on screen, you can click on the UPDATE icon on the toolbar [image: image51.png]


.
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Important

If any files are open at the time, it will still consolidate the latest saved version and give a warning that the file is READ ONLY.

In order to save the file for future use, save it to a file name as usual.

When you open the Consolidated file again, the system will ask if wish to use the current data or update from the latest file versions.

As new project files are added, simply

·  FILE menu, CONSOLIDATION, INSERT
· Hold the CONTROL key down, and click on each file to add new to the consolidate.
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You can change data in the Consolidated file. If you have the rights, you can save the changes back into the original files ..

· FILE menu, CONSOLIDATION, SAVE
· Select the files you wish to update and it will update those files.

Important

The file name is stored in the Project column. So in order to see the file that each task came from select the VIEW menu, MULTI PROJECT VIEWS. The Project column shows the file name…
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Report Generator
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The report writer wizard is simple to use and allows you to create column-based reports on task information. The Report Generator does not include combined reports of charts & graphs, resource and cost graphs / histograms / tables.

· Select the REPORT menu, NEW REPORTS WIZARD
· Click NEXT

· Type in a report title

· Click NEXT

· Choose the type of report required - opposite

· Click NEXT
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Click on each column that you require & then click on ADD TO REPORT.

· When completed, click on FINISH
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Important

Only suitable columns are listed under each report category.

If you require to access all columns, then choose the CUSTOM option.

There is a list and description of each field in the system, by selecting HELP menu, SUPPORT MATERIAL, COLUMN DEFINITIONS.

Resource Sheet

There is a new spreadsheet style option to create/edit Resources.

· VIEW menu, RESOURCE SHEET
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Important –  Do not overwrite the TO ASSIGN entry.

· Input on the next line
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MAXIMUM UNITS = the maximum number of resources to be used on the whole project

INFINITE = No (default) or Yes (if there is no maximum)

COST RATE = Rate per hour for an individual unit of resource

SYMBOL = Colour 

TEAM (Optional)

SKILL (Optional)

LOCATION (Optional)

CALENDAR = Standard(default)

TYPE = General (default)

To change the colour or calendar – double click on the relevant cell.

To exit the RESOURCE SHEET – click on the X at the top right of the window.

Resource Group assignments

Currently, multiple assignments need each resource to be added separately. Resources can now included in a Group and the Group can be assigned and it assigns all the individual resources and associated units.

First the resources must have been set up.
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Then to set up the Group …

· Click on the RESOURCE icon [image: image58.png]



· Click on NEW GROUP
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·  Enter a GROUP NAME

·  Enter the number of UNITS against each resources

· To assign, first create the task bar 

· Click on the RESOURCE icon [image: image60.png]



· Highlight the group name

· Click on the ASSIGN button

[image: image61.png]Assign Resources - [1]Task

T =
vame | st [ e f o {WnoR) % i fou Ef = —
# Joners — ——
o | ] e = [ —
[ —





All the resources are assigned to the task ….
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Important

There is a field called RESOURCE GROUP that can be inserted into any chart based view/report
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Resource assignment using the Resource Assignment window

Up to now there were 2 types of Assignment types … Fixed  = YES or NO. The operation of the RESOURCE ASSIGNMENT window has been changed.
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The FIXED column can be edited manually by keying in the letter Y or N. Also you can set the Fixed option when assigning through the RESOURCE ASSIGNMENT window…
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FIXED (YES) = FIXED DURATION

FIXED (NO) = RESOURCE DRIVEN

Fixed = YES, means that any increase in units / %utilise – will mean that the Duration remains static, but the WORK increases/decreases …
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Fixed = NO, means that any increase in units / %utilise – will mean that the Duration increases/decreases, but the WORK remains static …
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Constant Effort & Duration option for resource assignment

There is now a third option – CONSTANT EFFORT & DURATION. The option can be edited in the FIXED cell by typing a C.
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In this option, any increase in WORK will not change the DURATION – instead the UNITS and % UTILIZE is recalculated in order to ensure the work is fitted into the specified duration.

· Using the RESOURCE ASSIGNMENT window, first assign the resource
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· Change the FIXED to CONSTANT
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· Change the WORK to 30 hours (the % UTILIZE is recalculated)
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View by & sort by Resource team, skill or location
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To sort the bars using Location ..

· Select the VIEW menu, VIEW BY, LOCATION
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Filter by Resource team, skill or location

· Select the TOOLS menu, FILTER, LOCATION
· Choose from the list
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If the NUMBER ROWS box is not ticked, the tasks retain their own ID number. If this box is ticked, the ID numbers will be replaced by a consecutive row number.
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Important

To unfilter the tasks, click on the SHOW ALL icon on the toolbar [image: image78.png]



Intelligent paging

VERTICAL SETTING

The number of lines per page is set at the top of the screen [image: image79.png]pagett [} [20 =




In order to get more lines on a page, you can edit this figure. However, in the previous version, you there is no maximum lines for any size page – so that if you input too many lines, the text will cut off at the top & bottom and could be made unreadable.
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In this version, if the number of lines is too large for the printer page size, it will warn you that it needs more than 1 page and you have an option to use 1 or more pages.

If you click on OK, the whole document can be seen on-screen and the page break is marked by ticks on the side of the screen 
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If printed the report would print out on 2 pages as if continuous ….
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In terms of calculating the optimum page size, it takes into account the paper size, orientation, titles, legends, graphs & tables at the bottom.

HORIZONTAL SETTING
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Normally, the timescale is fit to 1 page horizontally; which can be changed using FORMAT menu, PAGE SETUP. 
For resource reports that utilise Histograms as a combined or stand-alone report, there is a minimum width for each vertical bar, so if the bars are too thin, it will calculate the number of pages horizontally needed to meet the minimum widths of bars for each period.

If you click on OK, the whole document can be seen on-screen and the page break is marked by ticks on the top of the screen 

Report settings
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All reports held under the REPORT menu have default settings. In order to display them ….

· REPORTS menu, EDIT

· Click on the down arrow for GROUP

· Choose the category

· Click on the Report & the PROPERTIES box
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By default settings for this Chart report is …
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COLOUR BY task

2. VIEW BY task

3. Show no BASELINE or PROGRESS LINES

4. No FILTER or SORT

5. Use ID NUMBERS

Important

These settings are used when opening a Report. When you choose a View, the current settings (for filter, sort, colour, etc) are still used. The user is free to change any settings using the menus while showing any report/view.

For example to filter a combined report, first select the RESOURCE menu, DISPLAY HISTOGRAM and click ON the INCLUDE FILTERED TASKS. Then when any filter is run (using TOOLS menu FILTER or the FILTER icon [image: image83.png]


. The FILTER both windows will remain on until it is switched OFF.
Reports – Progress

Several reports that involve a Baseline been renamed.

More options have been included in the Wizard for the following ..
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CHART & PERIODIC COSTS v BASELINE

Options

1. ROUND UP 1000’s = rounds up all cost figures to NEXT thousand

2. SHOW BASELINE = shows current baseline cost figures

3. HIDE ZERO = shows a blank instead of a zero

4. SHOW COMPLETED COSTS = displays the Actual costs on each task spread over the proportion of the bar completed (represented by the % complete)

5. SHOW FORECAST COSTS = if Actual Costs are input, the system will forecast costs to the end of the project for each task (if Actual Costs are not input, then the Forecast Cost will equal the Total Cost)

6. SHOW RESOURCE COST TOTALS = if Resources are costed using hourly rates, then they can be listed

7. SHOW CUMULATIVE COSTS = for every row where there is a Periodic figure, then an extra row is included for the cumulative costs

In the following example 
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This Wizard setting will create this table at the bottom of the chart …
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CHART & CUMULATIVE COST GRAPH v BASELINE
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SHOW PERIODIC COSTS = for every row where there is a Cumulative figure, then an extra row is included for the periodic costs

2. NUMBER OF LINES is the minimum of lines for the Cost Graph (more lines will used if needed)

In the above project, the Wizard would produce the following Cost graph at the bottom of the page ..
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Reports – Costs

More options have been included in the Wizards (as above) and 3 extra reports have been added …..
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RESOURCE COSTS
This report is not normally used – as it is used by Resources that are not categorised as General.

LUMP SUM COSTS & GRAPH

This is an easy template to allow lump sum costs to be added to each task to create a combined chart & cost graph ..
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COST HISTOGRAM
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Reports – Resources

More options have been included in the Wizards (as above) and 4 extra reports have been added …..

[image: image93.png]Resource Chart +Usage
Avaiabiity

Stacked Hstogram
Resource Graph




ADVANCED OPTION on WIZARDS
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By default, when a Resource Report is chosen, the full list of resources are used. In order to restrict the resource information used in any histogram, graph or table, click on the ADVANCED button and click on any resources – you wish to exclude….
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Important

For combined reports, the top chart is filtered separately (using TOOLS menu, FILTER).

RESOURCE USAGE
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Options

1.  GROUP BY = sums all work by the selected category (default by resource name)

2. SHOW DECIMALS = displays one decimal place

3. HIDE ZERO = show blank for zero

4. SHOW RESOURCE BASELINE = displays an extra row for each resource if a baseline is saved

5. NUMBER OF LINES = is calculated automatically (should not be changed)
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By changing the GROUP, the overall figure  will remain the same – but the analysis is different …
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Other options….
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TIMESCALE

1. [image: image250.png]Name




DAYS = changes the headings into days (month, date & day)… for this you may have to change the number of pages horizontally to view/print all the data (FORMAT menu, PAGE SETUP) 

2. WEEKS = default (month & week commencing)

3. MONTHS = changes headings to year & month

RESOURCE UNITS

1. HOURS = default (person hours)

2. UNITS = number of persons per period selected  *

3. WEEKS = number of person weeks per period selected *

* Should use DECIMAL option with these

BASELINE
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If a Baseline is saved and selected in the Wizard, then 2 rows are displayed for each resource/category
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MULTI HISTOGRAM
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Options

1. SHOW CAPACITY = show a vertical bar in silver grey for total number of hours (or units / man weeks)

2. SHOW RESOURCE BASELINE = shows a line of values on the bottom and a hollow bar outlined in purple (this may be obscured if the current values are greater than the baseline)

3. NUMBER OF LINES = the minimum number of lines needed is calculated automatically. This should only be changed (upwards) in order to show different interval values on the vertical scaling.

4. All other options are the same as for the Resource Usage above,
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CAPACITY & BASELINE
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BY A DIFFERENT GROUP
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CHART & RESOURCE USAGE

This displays a combined report of a barchart at the top of the page and Resource Usage table at the bottom.

Options

1. TIMESCALE = sets the headings for both parts of the report

2. NUMBER OF LINES = is calculated automatically (should not be changed)

All other options are the same as above,
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When a baseline is present, then a baseline bar is shown on the chart by default. In order to switch off, select the VIEW menu, BASELINE.
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CHART & HISTOGRAM

This displays a combined report of a barchart at the top of the page and Resource Histogram at the bottom.

Options

1. NUMBER OF LINES = the minimum number of lines needed is calculated automatically. This should only be changed (upwards) in order to show different interval values on the vertical scaling (The higher the number – then the less number of lines for the chart area on the page)

All other options are the same as above,
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RESOURCE CHART & USAGE
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This displays a combined report of a chart based report at the top of the page and Resource Usage table at the bottom.

The Wizard that appears is the same as Chart & Usage above.

AVAILABILITY

Options
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SHOW CAPACITY = show a vertical bar in silver grey for total number of hours (or units / man weeks)

2. NUMBER OF LINES = the minimum number of lines needed is calculated automatically. This should only be changed (upwards) in order to show different interval values on the vertical scaling.

3. All other options are the same as for above.
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The vertical bars and the figures at the bottom & left hand-side represent time available for working.

The totals at the bottom of the Histogram represent the total for all combined resources included in the report. If the total is negative – the words “over allocated” appear in the box.
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STACKED HISTOGRAM

Stacked histograms place each vertical bar for each resource on top of each other.

Options

1. SHOW OVERALLOCATION SHADING = shows a hatched red area above a bar if that resource below is over allocated (default = NO – hide)
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RESOURCE GRAPH
This graph represents the cumulative work for the chosen resources (shown as an area blue graph). 

Options

1. SHOW RESOURCE BASELINE = shows a cumulative line graph. Also the baseline figures are shown at the bottom of the graph and up the side to show the total work for each resource.
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RESOURCE TYPES

By default all resources are categorised(TYPE) as GENERAL.
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It is now possible to analyse resources as …
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Manpower can be analysed as LABOUR (internal) and SUBCONTRACTOR (external)

Multiple MATERIALS & multiple PLANT/EQUIPMENT can be attached to a task – individually costed

If types are used, the TYPES can be used as a sort/filter criteria.

WORK BASED DURATIONS

Task durations are based on work content (not working time)

MATERIALS SCHEDULING

For MATERIAL types, you can enter a Lead time for ordering and list out Materials needed with relevant dates.

Project Commander – updated features from version 6.4 to version 6.5

· Information icon

· Control Click – random row selection

· Comments (input and printing)

· Alert dates

· Issues

· Risks

· Change log

· Network diagram

Introduction

There are several new improvements in this version ..

1. We have continued to improve the feature that opens Microsoft Project MPP files. Due to some of the funnies in MS Project, we cannot guarantee 100% that we can open any mpp file, but the majority of straightforward files will be ok. If you have a problem or you think there are any errors, please email the mpp file to us at office@pmscsolutions.co.uk and we are happy to either update our software or to convert the mpp file to a .pc file ourselves.

You should always ask people that send you a hard copy of a mpp file as well as the electronic file and you should check that the data transferred into Project Commander is identical to the original in Microsoft Project.

2. The INI file is now installed in the default directory – this makes security easier to set for Systems Administrators/IT Departments.

3. You can attach unlimited comments to a task and view/print them.

4. Where you update the plan, you can set alert dates that will pop up every time you open a file, if they are early/late starting/ending.

5. Using CONTROL CLICK, you can select random task rows in order to perform a procedure (eg shift project, linking, changing bar colours).

6. An on-screen only network diagram has been included and using a Task form in a window below. It will show all links input on the barchart using the mouse or via the link list. The network diagram view will allow you to change, add and delete links using the task form.

7. For users where several people access the file to update it, there is a change log file – where each user can record the changes made. It may be useful for single users that wish to keep an audit trail of changes to the file.

8. You can enter risks and issues in separate logs and these are saved with the file. The risks and issues can be allocated to one or several tasks and updated, until resolved. This is very useful for companies using Prince2 – as the risks/issues can be stored with the plan.

9. There is a new Info column that shows if there are any comments, risks, issues, date constraints or alerts appertaining to any task – using a small coloured triangle.

10.  For multi project users, the way to set up the client tied to a project has changed.

11. We have included a new TASK LIST view that allows you to enter a list of tasks (up to 999) with no paging.

Modifications

· INI file  (pcprov65.ini) – user default settings

For stand-alone users, the .ini file (which contains your default settings) on previous versions was installed in c:\windows. The .ini file is now installed into the folder where Project Commander is installed (default c:\pc). Therefore, users with security on their pc, only need to have full read/write access to one folder (eg c:\pc).

If ever you need to restore the original defaults, there is a copy of the original installed ini file in the folder.

· Resource sheet
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The Resource Sheet is now a view and has no X on the top right window to close. It will close if another view or report is selected.

· View menu

There are several new items ..

Risk/Issues

Change log

Network diagram

Alerts

Show/Hide

Details are contained later in the document.

· Links

When you click on the Critical Path calculator icon in the Toolbar, there are now 2 further options. You can colour links between critical bars in red and any links that have a lag in blue. If both boxes are ticked any lagged links will be overridden by red.
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· Multi project – Project & Client

The project and client are now entered using the Tools menu, Projects.

Toolbar icons
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There are 2 new icons on the right 
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This will hide links and associated text (for off-page and hidden tasks). You re-click to display again.
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  Display the Information column in the current view. You re-click to hide again. 

Information icon
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There are 4 different positions for coloured triangles placed at each corner of the Information cell …

	Position
	Feature
	Colour

	Top left
	COMMENTS
	yellow

	Bottom left
	Fixed DATE CONSTRAINT
	red

	Bottom left
	Unfixed DATE CONSTRAINT
	blue

	Top right
	RISK
	red

	Bottom right
	ISSUE
	blue


A yellow triangle in the top left hand corner shows that a Comment is present on that row.

A red or blue triangle in the bottom left hand corner shows that a Date constraint is present on that task (Date constraints are input using the View menu, Task Form – Links, constraints TAB)
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A red triangle says a FIXED constraint (such as MUST START ON, MUST FINISH ON, START NO LATER THAN or FINISH NO LATER THAN) is present on that task.
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A blue triangle says a UNFIXED constraint (such as START NO EARLIER THAN or FINISH NO EARLIER THAN) is present on that task.
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A red triangle in the top left hand corner shows that there a Risk Log entry associated with that task.

A blue triangle in the bottom left hand corner shows that there a Issue Log entry associated with that task.

A diamond shape in the centre of the cell shows that an ALERT is present.
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A green diamond shows an ALERT that is present  - but is not signalled as a warning. (Date constraints are input using the View menu, Task Form – Links, constraints TAB)
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A red diamond shows an ALERT that is present and is signalled as a warning that the task does not meet the alert status.

Control click – random row selection
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Currently, you can select a continuous range of rows, by dragging down the ID (or Row) column or using Shift click (ie. Click on first ID and then holding the shift key down – the arrow up key used for capitals) and clicking on the last ID in the range.

Now it is possible, by holding the Control key down continually, click on the ID numbers which you wish to select. It will highlight the rows as opposite.

Then you can perform such features as follows to the rows selected …

	· properties

	· shift project

	· auto link

	· cut

	· copy

	· paste

	· clear

	· insert row

	· format cells – background and font

	· Indent/outdent


[image: image269.png]view Format  Tools

2Zoom,
Freeze Panes

Task form

Risksfissues
Change log

Viewy.
Colour chart by




Comments

Comments can be added to any row. Right click on the ID or Row number and select Insert Comments. Multiple lines can be saved in the comment window.
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Once saved by clicking on OK, the comment for any task, can be displayed on-screen by clicking on the ID (or Row number) and holding the left mouse down. 


A box will appear showing data regarding the task and at the bottom will be all the comments text.

The text can be seen on it’s own, by right clicking on the ID and selecting Edit Comment.

It is possible to see an indicator (yellow triangle) if you insert the Information column, by clicking on the [image: image126.png]


 icon on the toolbar. This inserts a column next to the ID column.

You can print the comments on their own, by File menu, Print task comments or you can print them at the end of the barchart on a separate sheet by File menu, Print and click a tick in Print task comments.

Alert dates

Alert Dates are useful for users that update their projects to reflect revised new task start/end dates and want Project Commander to warn if a task is starting/ending too early/late. The warning will appear continually at start up of the file unless resolved.

Alert Dates are input using the View menu, Task Form – Links, constraints TAB.
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There are 4 alerts …
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Early start - an alert message/icon is triggered if the task start date is before this date.

Late start -  if task start date is after this date.

Early finish - if the task end date is before this date.

Late finish -  if task end date is after this date.

A diamond shape in the centre of the cell shows that an ALERT is present.
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A green diamond shows an ALERT that is present  - but is not signalled as a warning.

A red diamond shows an ALERT that is present and is signalled as a warning that the task does not meet the alert status.


When you enter an alert date in the Task Form, an Alert warning message will immediately appear on-screen, if the alert is triggered. 
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Once added, the alert can be seen also by clicking on the ID Number and holding the left hand mouse button down.

Note- only one alert can be placed on each task.


Each time you start up the file, a warning message will show for Alerts activated. At this stage, you can ask to see a filter report on-screen by clicking on SHOW TASKS or go direct to the whole plan by clicking CLOSE.

If you choose to Show the Alerts, you will get a filtered view, and all tasks that do not have Alerts or activated Alerts.

Then to return to a unfiltered view (ie see all tasks), select Tools menu, Filter, All tasks.

Note – you will see that once you have filtered a view, then a message appears at the top of the page under the project title.
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In order to switch this off, select, the Format menu, Title and click OFF the tick for Show Filter/Sort Description.

Also it is possible to view all task bars and show the bars that are effected by Alerts without having the Information column present on screen. Select the View menu, Colour Chart By, Alert. It will show activated alerts in red, unactivated alerts in green and all other bars in white.
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In order to revert the colouring system back, Select the View menu, Colour Chart By, Task.

Issues

A log of issues can be stored with the file and viewed and printed separately. Each issue can be associated with more than one task. The design of the Issue Log follows recommendations of Prince 2.

To enter an issue, select the View menu, Risk/Issues, Issue Log. The Issue Log window can be moved and resized and stays on top of the screen until closed.
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Click on the New Document icon

· Ref 

This field has been designed for numerics and will increase the number by 1 when you create the next issue entry. However, you can edit this box and enter any alphanumeric entry as a unique reference number.

· Issue Type
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There are 3 options..

RFC is a Request for change.

Off-Spec is a change that was not included in the original project.

General covers all other options.

· Date identified

The current date is generated here – but can be changed if the issue was entered later.

· Title

This is used in the summary Issue Log window – so is important to describe the issue to identify it – only the first 30 characters appear in the window
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· Description

You can enter a full description (especially for printing)

· Owner

The name or initials of the person/department/company responsible for the resolution of the issue.


· Status

There are 4 status types ..

Active – default for new issues.

Closed – means the issue has now ceased.

Ongoing – means that the issue will continue to appear throughout the project.

Not active – the issue has been recorded for the future and is not to be taken into account yet.

· Status Date

The current date is generated here – but can be changed if the issue status was entered later or with a future active date.

· Progress

A full history of progress of how the issue is being dealt with.

· Tasks

This is generated by the system and displays the number of tasks associated with this issue. Until issues are linked to tasks (see below), then this number will remain zero.
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ICONS
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New issue
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Edit highlighted issue (alternatively – double click on any issue listed.
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Delete currently highlighted issue in the list.
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Print the current list using the Print settings on the [image: image142.png]


 icon.
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Save the Issue log to a text file (RTF) to view in Word, etc.
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Link a single or multiple highlighted task on the chart (using the ID/Row column) to the highlighted risk in the list.

Multiple tasks on the chart can be highlighted by holding the CONTROL key down and clicking on the ID/Row No. of each task. To highlight a range of consecutive rows, hold the SHIFT key down and clicking on the ID/Row No. of the first and last task.

[image: image145.png]I s s
I il I il I

ofo| name | s pursornsn
NENNE NN ENE NN
3 © uvems| 13a [1swons|





If the INFORMATION column is switched on, then a blue triangle will appear against each selected task . In this example, the TASKS column on the list will show that the particular risk is linked to 2 tasks.
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In order to link the highlighted risk to another task, click on the ID number on the chart and click on this icon.
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To delete all links to tasks for that issue, highlight the Issue and click on this icon. A message will ask you to confirm by saying YES.
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To see which tasks are linked to any Issue, click on this icon and on the chart, it will highlight the tasks in the ID column of the tasks effected.

The Issue list can be filtered using the drop down box. The default is to show all Issues, but they can be selected using issues with an Active, Closed or Ongoing status.
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This icon displays the Print settings

Risks

A log of risks can be stored with the file and viewed and printed separately. Each issue can be associated with more than one task. The design of the Risk Log follows recommendations of Prince 2.

To enter a risk, select the View menu, Risk/Issues, Risk Log. The Risk Log window can be moved and resized and stays on top of the screen until closed.

Click on the New Document icon

· Ref 

This field has been designed for numerics and will increase the number by 1 when you create the next entry. However, you can edit this box and enter any alphanumeric entry as a unique reference number.


· I (for Impact)

There are 3 possible entries (the default is Medium)
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· Category

There are 3 possible entries (the default is Project)
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· Date Identified

The current date is generated here – but can be changed if the risk was entered later.

· P (for Probability)

There are 3 possible entries (the default is Medium)
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· Owner

The name or initials of the person/department/company responsible for the resolution of the risk.

· Title

This is used in the summary Risk Log window – so is important to describe the issue to identify it – only the first 30 characters appear in the window
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· Description, Solution and Contingency

You can enter a full descriptions for each (especially for printing)

· Status

There are 4 status types ..

Active – default for new issues.

Closed – means the issue has now ceased.

Ongoing – means that the issue will continue to appear throughout the project.

Not active – the issue has been recorded for the future and is not to be taken into account yet.

· Status Date and Target Date

The current date is generated here – but can be changed if the Risk status was entered later or with a future active date.

· Progress

A full history of progress of how the issue is being dealt with.

· RAG 

There are 3 status types ..
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· Tasks

This is generated by the system and displays the number of tasks associated with this issue. Until issues are linked to tasks (see below), then this number will remain zero.
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ICONS
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New issue
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Edit highlighted issue (alternatively – double click on any issue listed.
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Delete currently highlighted issue in the list.
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Print the current list using the Print settings on the [image: image162.png]


 icon.
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Save the Issue log to a text file (RTF) to view in Word, etc.
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Link a single or multiple highlighted task on the chart (using the ID/Row column) to the highlighted Risk in the list.

Multiple tasks on the chart can be highlighted by holding the CONTROL key down and clicking on the ID/Row No. of each task. To highlight a range of consecutive rows, hold the SHIFT key down and clicking on the ID/Row No. of the first and last task.
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If the INFORMATION column is switched on, then a red triangle will appear against each selected task . In this example, the TASKS column on the list will show that the particular risk is linked to 2 tasks.
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In order to link the highlighted Risk to another task, click on the ID number on the chart and click on this icon.
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To delete all links to tasks for that issue, highlight the Issue and click on this icon. A message will ask you to confirm by saying YES.
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To see which tasks are linked to any Risk, click on this icon and on the chart, it will highlight the tasks in the ID column of the tasks effected.

The Risk list can be filtered using the drop down box. The default is to show all Issues, but they can be selected using issues with an Active, Closed or Ongoing status. 
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This icon displays the Print settings

Change Log

A log of changes can be stored with the file and viewed and printed separately. No entries can be deleted once entered – to ensure the audit trail.

The extent of the log, depends totally on if it is used extensively by all users of the file.

To enter on the log, select the View menu, Change Log. The window can be moved and resized and stays on top of the screen until closed.

Click on the New Document icon
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· Ref 

This field has been designed for numerics and will increase the number by 1 when you create the next entry. However, you can edit this box and enter any alphanumeric entry as a unique reference number.

· Date identified

The current date is generated here – but can be changed if the issue was entered later.

· Author

Person entering the log.

· Description

You can enter a full description (especially for printing)

· Approved by

Person authorising entry

ALL FIELDS MUST BE ENTERED to allow you to save the entry.


No entries can be deleted once saved – but can be disregarded by double clicking and tick the DISREGARD box.

ICONS
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New issue
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Print the current list using the Print settings on the [image: image176.png]


 icon.
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Save the Issue log to a text file (RTF) to view in Word, etc.

The Log list can be filtered using the drop down box. The default is to show all Changes, but they can be selected using only active changes (ie Don’t show disregarded)
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The Log list can be sorted using the drop down box. The default is to show all Changes in the order entered, but they can be sorted using the Date entered.
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This icon displays the Print settings
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Network Diagram

You can view a Network diagram for linked tasks. The window is constructed in such a way that the only the ID numbers are shown in boxes linked and a full list of tasks down the right hand side and the Task Form at the bottom.
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Each compartment of the window is synchronised on the same task. You can choose the highlighted task by …

· Click once on a box

· Click on a task in the task list

· Click on NEXT/PREVIOUS buttons in the Task Form

It is possible to enter new links in this window to existing tasks by highlighting the ID number on the list and entering a Predecessor or Successor.

If you wish to enter a new task, click on the last task on the list and then click on NEXT on the toolbar and enter a Name, Start date & Duration (as normal)
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If the network diagram area is insufficient to contain all the tasks, a scroll bar will appear on the bottom and right hand side of the diagram. If the list area is not long enough, a vertical scroll bar will appear.

If there a large number of tasks/links, you can highlight any task and the diagram will centralise the network graphic around that task in the centre.

The Network Diagram is only available as a on-screen report (it cannot be printed out). However, the Link List can be printed still in order to report all links in hard form.

Extra NEW feature in 6.5 – Build 2315   Task List

When you start up Project Commander, it defaults into WYSIWYG mode – which means you see each page on the screen as it would print. 

Now if you want to enter tasks (and link them) in a list, you can select the VIEW menu, TASK LIST. This opens up a list of up to 999 consecutive rows with the same fields as the Basic View. Note it is not possible to Zoom this screen.

Two messages appear. Click on YES. As the message says, the print is disabled in this mode (you will need to exit this View and choose another View in order to set the LINES PER PAGE and determine the number of pages required)

The whole project timescale is fitted by default to one screen’s width. If you wish to spread the timescale over several screens horizontally, change the 1 to a higher figure.

Linking with the mouse

Normally you cannot link beyond the bottom of the screen or across pages. In the TASK LIST view, if you have a mouse with a scroll wheel, you can start to draw a link (key your finger pressed down on the left hand mouse button) and then with a second finger, turn the wheel forward to scroll down the chart and release off when linked to the other bar. 

[image: image184.png]14

Task{17]
~{From:Fit2/m1/07 wk2 [+
To: Tue 05/02/07 wk

' | Diration =184 (350)
16 |
18 |
19 i





To print

In order to return to the normal WYSIWYG mode and to be able to print, you must choose another View.
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